
About the database stress testing tool

DTM DB Stress is a utility for stress testing the server parts of information systems and 
applications, as well as DBMSs and servers themselves. This tool allows you to create and 
configure a continuous set of requests to the server of the OLAP (query execution) and 
OLTP (adding, modifying and deleting data in the database) types. At the same time, the
user can flexibly change both the number and the priority of this or that type of requests to 
a database or an application.

The program is useful for any information system developer or any QA department 
employee who wants to make sure the product under development can work with a large 
number of simultaneous connections and concurring queries and transactions. Database 
administrators can use this utility to evaluate the current performance of servers and to 
make plans about increasing processing power.

A test project consists of a set of tasks. Each task is an SQL statement that will be
executed in a loop in the process of testing. Each task can be run as several copies running 
simultaneously in separate threads. Tasks have different properties and priority. In the last 
three cases those iterations that are already in process are not interrupted, but executed 
to an end, that is why the actual number of executed iterations may exceed the specified 
value or time a little.

DTM DB Stress is a Windows application, known to be compatible with the following 
operating systems: Windows XP, Windows 2003 and newer Server family and Windows 
Vista, 7, 8/10 (desktop). The 64-bit edition is also available.
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Product Versions

There are three versions of the software product. Please refer the following table to explore 
differences between the product versions.

With professional and enterprise versions you can use runtime license. This license allows 
your team to run stress test process without full DTM DB Stress license.

* - your operating system can limit the number of threads. For most cases, this limit is 
about 2028 threads.

Option Standard Professional and 
Runtime Enterprise

Maximum number of concurrent 
threads 64 Unlimited* Unlimited*

Maximum number of SQL 
parameters 10 99 99

Values file delimiter customization No, TAB only Yes Yes

Product Settings export and import 
features No Yes Yes

Statistics interval customization No, 30 seconds 
only Yes Yes

Custom task connections No Yes Yes

Import script feature No Yes Yes

"By group" execution mode No Yes Yes

Built-in data generator No Yes Yes

Task prologue and epilogue scripts No Yes Yes

Console mode No Yes Yes

SQL Library No No Yes

The report comparison feature No No Yes

The report Visualizer No No Yes

Visual Source Safe support No No Yes

Performance counter feature 
support No No Yes

The execution plan feature support No No Yes
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Stress project execution modes and methods

There are three execution modes: concurrent, sequential and ' by group'.

There are several methods to finish a project (job): 

1. Manual, when the user himself has to click the Stop button at the execution console or 
toolbar. 

2. According to the properties of each task - each copy of each task is executed as many 
times as specified in its properties.

3. By time - all tasks will be running at least for the number of seconds specified by the
user. The control precision is about 0.5 seconds for this method. 

4. By the overall number of executed iterations. A project is finished if the overall 
number of iterations for all copies (threads) of all tasks exceeds the specified value.

5. By the number of times each task is executed. A project is finished when each copy 
(thread) of each task is executed the specified number of times. 

6. By the number of times each thread is executed. A project is finished when thread 
copy of each task is executed at least the specified number of times.*  

* - this method is not compatible with 'sequential' and 'by group' modes.
 

All or checked threads can be paused. To continue execution use the same Pause/Continue 
button.
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Task Properties

This dialog box helps you to set task properties. All properties are grouped into four sets: 

1. General properties 
2. Options 
3. Parameters 
4. Custom connection*  

5. Prologue and epilogue*  

* - for Professional and Enterprise versions only. 

The program shows connection information for this task at the bottom of the window. By 
default, it is same connection as specified at the main window. However, users of the
professional version allowed to specify the custom connection for any individual task.
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General Task Properties

This dialog box helps you to set general task properties. The most important properties 
are: 

1. Task name - displayed in the task list in the main program window.  
2. A number of concurrent threads the program should create for a task of this type. 
3. The text of the SQL statement representing the content of the task - it is exactly what

will be executed within this task. You should switch on "Use SQL parser" option in 
case you want to use complex script (set of SQL statements). "go" or ";" statements 
separators are recommended. There are two ways to specify SQL script: immediately 
entering or external file reference. 

Also, this dialog box allows you to load an SQL statement from a file on the disk (the
"Load" button), from SQL Library and to test if the current statement is correct (the "Test" 
button).

The stress tool allows you to select one of three ways to use the file with data. In the first
case, all task threads use the file with data independently. It means that they open the
file on their own and sequentially process records in it. In the second case, each thread 
uses only one set of values (a string with data) from the file. In this case, the number of
strings in the file with data must coincide with the number of threads launched for the 
task. The third way is when all threads read from the file sequentially.

"Use SQL parser" option instructs the tool that source SQL script should be split to a few 
SQL statements. The program executes it sequentially in this case.
When the option is switched off (by default) DTM DB Stress passes the whole script to 
database directly.

"Run the whole script as a single transaction" works together with "SQL parser". If the 
option is switched on the stress tool start transaction at the begin of the script execution
and commits it and the end. Otherwise, the program uses "autocommmit" mode, i.e. each 
SQL statement is one transaction.

Note: the user can specify default values for most important task properties at Settings 
window.
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See also: import SQL script feature.
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Additional Task Properties

This tab helps the user to specify additional properties of the task.
They are:

1. A number of iterations to be performed before the task is executed. Important: this
option works with "by task property" execution mode only. 

2. Task priority - normal, high or low.  
3. The delay between iterations during the task execution. The user can specify minimum 

and maximum interval size. The program uses exact interval size in case right border 
not specified or <= than the left border. 

4. The delay between SQL statement execution (for tasks that contain more than one 
SQL statements). The user can specify minimum and maximum interval size. 

5. The program can add a delay between the first SQL statements execution for the 
script mentioned above. Please set up "Initial statement delay" value (0 by default) 
for this purpose. 

6. Fetch all obtained records into the result set or only the specified number of the first 
ones. This option makes sense only for tasks that produce a result set.

7. Output information for the task. The program will create data file 
"Task_#_Thread_#.txt" with fetched data if this option is switched on and the user 
provide correct output folder. The file format is tab-delimited without column header.  

8. Group number (Professional and Enterprise versions only) 
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Parameters for the Task

This tab helps the user to specify parameters for dynamic SQL statements. The value 
separator in the file with values can be specified as well.

 

Note: %PRODUCT_PATH% macro can be used to specify a relative path to the installation 
directory.

See also: built-in data generator. 
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Connection Task Properties

This tab helps you to specify a custom connection for the task. This option is available in
the Professional and Enterprise versions only.
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Prologue and Epilogue Scripts

The user can define scripts for execution before and after main task's activity. It helps the 
user to prepare environment like enable or disable triggers, update indexes, etc. This 
option is available in the Professional and Enterprise versions only.
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Groups of Tasks

A few tasks can be united to a group. The only reason of this operation is "by group" 
execution mode usage.

When you use this execution method the stress tool runs all tasks of the first group, wait
for all group tasks, runs the second group, etc. The Standard edition of the tool does not
support this method.

Important note: you must enumerate groups sequentially starting from 0.
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Execution Console

The Execution console is a window that shows the current status of the stress project 
execution.
It contains one line for each thread of the project. About each thread the console window 
shows:

 Name of the thread's task. 
 A number of the threads of the task. 
 Thread status.
 How many times the thread was already executed. 

 

Please note that you can run project's task sequentially or "by group" instead of concurrent 
with the related item in File menu or toolbar buttons.
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Execution Report

The program can create three report types. They are:

1. HTML report contains summary information, execution times for project, tasks and 
threads. 

2. Text/Excel report contains threads-level information in machine readable tab-delimited
format. It can be open by Microsoft Excel. 

3. SQL statements report. This report contains actually executed SQL statements with 
the time of execution and fetching. 

4. Internal report. This report is suitable for report comparison and available in the
Enterprise edition only. 

The following table describes most important report items.

Item Description

Project Initialization Time Sum of initialization time of all active project's tasks

Total Project Execution 
Time

Actual (objective) time of the project execution including 
initialization and termination

Execution Mode Please, refer to "execution modes" for details

Task Initialization Time Actual (objective) time of the task preparation including all 
threads creation and run

Total Task Duration Sum of all task's threads execution time

Executed times Number of completed iterations of the current thread

Average Speed Average number of completed iterations per second

Max Duration Maximum time (seconds) was spent to current thread 
execution

Min Duration Minimum time (seconds) was spent to current thread execution

Total Duration Total thread execution time including initialization and data
rows fetching
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Built -in Data Generator 

To make project rule more flexible the program contains simply data generator. It offers 
three predefined generators:

1. Random integer. The user can specify value range. 
2. Random string. The user can specify length range and type of characters. 
3. Random date and/or time. The user can specify value format. 

Moreover, the user can specify custom pattern for data generation. There are pattern 
items:

 A - letter from 'A' to 'Z'.  
 a - letter from 'a' to 'z'.  
 N - digit from '0' to '9'.  
 X - hexadecimal digit from '0' to '9' and 'A' to 'F'.  
 {n} - repeater, value will be used from 1 to n times. n should be from 1 to 999.  
 {=n} - repeater, value will be used n times.  
 {n;m} - repeater, value will be used from n to m times. n should be less then m and 

both numbers from 1 to 999. 
 # - copy value of the last used block of elements signed by ( and ).  
 $<function>(<parameters>) - call built-in generator's function.  
 $$(<expression>) - calculate expression value.  

Note: you can use '\' character for escape next mask sign. For example, \a will be used as 
a 'a' letter without any replacements. 

Examples:

Please contact our support staff if you have difficulties during complex patterns creation or 
built-in functions usage. 

Description Pattern Sample results

IP address $Rint(0,255).$Rint(0,255).$Rint
(0,255).$Rint(0,255)

41.107.214.235
187.239.95.95
190.212.237.81

From 3 to 5 days after 
today $$($Today(DD.MM.YYYY)+$RInt(3,5))

14.12.2008
15.12.2008
14.12.2008
13.12.2008

One year after some 
date $$($Date(12.10.2008,DD.MM.YYYY)+365) 12.10.2009

e-mail [a{3;6}.]a{3;7}\@a{3;8}.
tlsg.psf@dpo.com
xzbcoej@vpv.org
ygp.eylfpbn@ljvrvipy.net
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Project Properties

The project has a few optional properties those helps stress testing process more flexible.
Most important are:

1. A file what the program will use to save all executed SQL statements.
2. Report files for HTML, SQL, internal and text (Excel compatible) output. 
3. Report description (note). 
4. Report author. 

Please note that you can use $DATE$ and $TIME$ macros in the names for all mentioned 
files.
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Database Connection

Quick Start: how to connect?

There are five ways to connect to a database:

1. Direct connection 
2. Connection to desktop files 
3. Data source with ODBC, IDAPI or Oracle Call Interface (OCI) 
4. DSN File connection 
5. OLE DB connection 

In all modes the "Test" and "Information" buttons, as well as tools for working with
connection profiles are available. "Test" button allows you to check information you entered 
and/or data source (or alias) configuration. 

See also:

 Troubleshooting guide 
 Connection information 
 Connection profiles 
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Connection Quick Start Guide

Database How to connect

MS SQL Server Enter or select server name at the direct connection panel

Local SQL Server 
Express

Enter .\SQLEXPRESS as server name at the direct connection 
panel

Oracle
1) Switch to data sources mode
2) select OCI as "Interface"
3) select your service name from data source drop-down menu

DB2 Use direct connection panel or 
Use predefined ODBC DSN for custom connection settings

MySQL
Install ODBC driver for MySQL from www.mysql.org
Use direct connection panel or
Use predefined ODBC DSN for custom connection settings

PostgreSQL Use direct connection panel or 
Use predefined ODBC DSN for custom connection settings

Interbase/Firebird
Install ODBC driver
Use direct connection panel or
Use predefined ODBC DSN for custom connection settings

Microsoft Access 1) Switch to "Desktop File" panel
2) Select "Access" as file type, enter or select file name

Microsoft Excel 1) Switch to "Desktop File" panel
2) Select "Excel" as file type, enter or select file name

Another database

1) Install ODBC driver for your database system
2) Create ODBC data source name using Windows ODBC 
Administrator
3) Switch to data sources mode
4) select your data source from drop down menu
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Direct Database Connection

Direct Connection

The direct connection method allows you to connect to most popular databases (MS SQL 
Server, Oracle, Interbase/Firebird, MySQL, PostgreSQL and DB2). 
Enter the server name and the database name, if required. The user name and password
are optional. Their necessity depends on the settings of your database. The owner name
(schema) is optional too. The list of visible database objects depends on the choice of the
owner. If the owner is empty, you will access all objects. There is important that
schema/owner name is case sensitive. 
If you do not find the required database type in the list or cannot connect directly, use a
connection through the predefined data source. If DBMS is in the list, but unavailable, it
means that either the required ODBC driver is not installed or it is not configured properly.  
During its use, the program stores the entered values of server names, users and owners.
You can select a value from the stored list using the corresponding combo box. For some
DBMS types (MS SQL, for example), the program can fill the list of available databases.
Use the button with two arrows for this purpose. 

DBMS-specific connection options 

Microsoft SQL Server

 "(local)", empty or "." server name means local server 
 use <server name>\<instance name> syntax to identify instance. Example: 

.\SQLEXPRESS means SQL Express at the local system 

Oracle

Use connect string for the Oracle Server that you want to access as a Server name.

Important: it is strongly recommended to use native Oracle Call Interface (OCI) instead of
direct connection.

Interbase and Firebird

Examples: 

 Server: localhost and Database c:\interbase\myDb.fdb - connect to specified DB on 
local system.

 Server: 172.17.2.10/3051 and Database /usr/local/db/myDb.fdb - connect to 
specified server with alternate port 3051 on remote system 172.17.2.10 

MySQL
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 Use localhost for local MySQL 
 example.com;port=3306 means MySQL at example.com on 3306 port 

DB2

ServerName;port=5000;protocol=TCPIP as a server name means connect to 
ServerName, use 5000 port and TCP/IP protocol. 

PostgreSQL

ServerName as a server name means connect to ServerName, use 5432 port and TCP/IP 
protocol. Database name is required. localhost as a server name is acceptable. To specify 
custom port you should add ";port=NNNN" string to server name.
server_name_or_ip-address;port=5432;DATABASE=dbname 
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Desktop File Connection

Desktop Files

The second way is designed for connecting to desktop data files. Select the required format 
and specify the file name or the directory where the data is located. Other parameters are
optional. 
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Data Sources

Predefined data sources: ODBC, IDAPI, Oracle Call Interface

A connection with the use of a data source is the most universal. You can select ODBC,
IDAPI or OCI (if installed) interface and the preconfigured data source name. In this case,
other options are similar to those of a direct connection. The "Manage" button allows you
to get access to the external configuration utility if it is available. When you want to
access the tables belonging to the single database schema (or owner), you should fill the
"owner" entry; otherwise, all tables will be accessed. 
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File Data Source Name

DSN File

The fourth way is using a DSN file. For this case, just select the file name with DSN
definition. 
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OLE DB Connection

OLE DB connection

Use 'Configure' button to specify connection information. Password and owner fields are
optional. 
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Connection Profiles

Connection profile helps you to save information about your connection (interface, data
source or alias name, user name (login), password and database name, etc) and get access 
it by the one click. 

Please fill connection properties and press "Add as new" to add a new profile. To modify 
the profile you should select it from the list at the top of the window, modify properties
and press "Update". "Delete" button works when you select the profile to be deleted in the 
list.

"Save" and "Load" buttons allow you to save profiles to the disk file or load them. The 
"Export one" button helps to save single currently selected profile.

Important: all profiles are shared between all installed DTM soft products. That means 
once created profile can be used with any tool. At the other side if you remove the profile 
from the list you can't use it with DTM soft's products anymore.
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Connection Information

The program provides detailed database, connection and driver information and properties. 
The "Information" button at the connect window allows you to view it. 
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Database Connection Troubleshooting Guide

Troubleshooting Guide

Problem description Possible reason Solutions

Required database type not 
present in the list at Direct
Connection and Desktop 
Connection pages

 

Switch to "data source" 
connection mode and select data 
source from the list or configure 
new one with "Manage" button.

Required format is in the 
direct connection list, but not
available (disabled).

ODBC driver for your 
database does not
installed or not
configured properly.

Install required driver. If it is 
already present in the system, 
please contact our support staff.

Errors during direct 
connection. Compatibility problems. Try to create data source for 

your database connection.

Login error for correct user 
name and password.

Read-only desktop data 
file.

Try to change file mode to 'read 
and write'.

I can't see relationships, 
defaults, etc in my Access 
Database.

Access interface.

Try to switch on "Use Microsoft 
Jet" check box at the "Desktop 
File" page of the Connect 
Window.
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Execution Statistics

The program allows you to collect and display statistics about the execution of several 
tasks or threads. Not more than 5 by default. If there are more tasks or threads, the first 
ones are only used. This statistical information is used for evaluating changes in the
performance over time. You can set a period for the statistics to be refreshed and some 
other options.
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Product Settings

The program has some settings and options to make your work more comfortable. The 
settings collected to three pages: general settings, report properties, and task properties.

The export and import settings features (Menu->Tools->Export/Import Settings) help users 
to move the software to another system.
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General Settings

The general settings page contains following items:

 "Stop on error" interrupts thread (virtual user) execution on the error when switched 
on. 

 Statistics mode: by the task or by the thread. In the first case, the program calculates 
a total value for all task's threads. 

 Statistics update: per period or per second. In the first case, the program updates the 
graph and statistics panel after each task's iteration. 

 Statistics update interval, seconds. The save interval will be used for performance 
counter report. 

 SQL library location (directory). 
 Logging mode: disable, normal or full. 
 Log file location.
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Task Settings

The general settings page contains default task properties i.e. properties of new task:

 A number of iterations. If the task created with "by task properties" option, this value 
defines a number of executions of the task script. 

 A number of threads. It is a number of concurrent virtual users defined by this task 
script. 

 Iteration interval between N and M. The program will add fixed (N equals M) or random 
(N<M) interval between script executions. 

 Number of rows to be fetched 
 Thread of the task priority (normal, low or high). 
 Initial delay. The delay before the first iteration.
 The maximum size of a large object to be fetched. 
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Reporting Options

The report page of the settings allows the user to define columns to be included in the
HTML report. Also, the user allowed to define a title for the report and let the program 
know to include SQL statement's text to the report.

See also: HTML report customization and localization.
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Execution Diagram

Besides using text for displaying statistics , the program allows you to build a diagram on 
how many times this or that task or thread is executed for the specified period. This 
diagram is not precise and can be used only for evaluation. Currently, available version of 
the program shows the diagram for 50 intervals and up to 5 first tasks or threads. The 
period and information type (tasks or threads) are used the same as for statistics.

Please use report visualizer for the detailed presentation of execution or comparison 
reports.
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Built -in log viewer 

This panel shows last rows of the program log.
To view complete one please use "Tools->Log" menu item or Ctrl+L hotkey. 
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Hotkeys

Hot Keys

Hotkey Function or Option

Ctrl+A Open "About" window

Ctrl+E Run the Project sequentially

Ctrl+D Move the task down

Ctrl+G Run the Project by group

Ctrl+L View log file

Ctrl+N Create new empty project file

Ctrl+O Load Project file from the disk

Ctrl+Q Quit the program

Ctrl+R Run the Project

Ctrl+S Save Project file to the disk

Ctrl+T Add new task

Ctrl+U Move the task up

F1 Open help

F2 Open the connect window

F3 Close the database connection (disconnect)

Ctrl+F4 Save HTML report for the current project

Ctrl+F8 Enable or disable currently selected task
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Dynamic SQL Statements

The program supports dynamic statements as well as static statements. Their final state
will be defined at the moment of execution. To make it possible, special tags (like ?1, ?2,
etc.) are inserted into the text of a statement. Those tags will be replaced with the values
from the file or generated randomly. They are always replaced, even inside string 
constants.

The file with values is a text file. Each line in it corresponds to one statement (single
thread execution), while values are separated by the separator character specified in the 
task properties. By default, columns should be separated by <tab> sign but professional 
and enterprise versions users can select or define custom columns separator. If there are 
more values in the file than in a statement, extra values are ignored. If there are more 
tags than values, tags with bigger numbers will not be replaced with any values.

There are three ways to share values file between task's threads. They are:

 Independently. In this case, each thread uses rows line by line. 
 Sequentially. A thread uses next row after last used by same or another task's thread. 
 Fixed. Each thread uses the unique line: the first thread uses first line, the second 

uses second, etc.

Examples:

SQL statement 
template Values file content Actual statements

select * from ?1
table1
table2
table3

select * from table1
select * from table2
select * from table3
select * from table1
etc.

select ?1 from ?2 order 
by ?1

field1<tab>table1
field2<tab>table2

select field1 from table1 order 
by field1
select field2 from table2 order 
by field2
select field1 from table1 order 
by field1
etc.

?1

select * from table1
insert into table2 values
(getdate())
sp_helptext 'dbo.tr12_t'

select * from table1
insert into table2 values(getdate
())
sp_helptext 'dbo.tr12_t'
select * from table1
insert into table2 values(getdate
())
sp_helptext 'dbo.tr12_t'
etc.

 



�
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Command Line Options

DTM DB Stress supports following command line switches:

-r - if present, run specified or recent project at program startup; 

-q - quit application after project execution. 

-@ - use custom connection profile. 

-c - console mode*.
 

-x - disable connection restoring. Please use it for corrupted profiles or incorrect connections only. 

* - supported by Professional and Enterprise versions only. 
You can use project name as a command line parameter.

Connection profile can be created by Export button at the Connect Window.

The console mode is a mode when the program doesn't open any dialogs and doesn't need any 
interference from the user. A project file for the console mode must be prepared and tested
beforehand. The program will use the recent database connection in console mode.

Example:

"C:\Program Files\DTM DB Stress\stress.exe" -r -@d:\acc.conprof "d:\MyProjects\Clients Activities.stp" 

Important: you should quote executable and project name if spaces are present in the path.
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Performance Counter Support Option

The Performance Counter support provides a module that can work with DTM DB Stress 
Enterprise editions. This module allows the user to create an HTML report based on system 
performance counters. An important option of the module is support remote system as well 
as local counters.

Also, performance counter value or values can be added to SQL report or text/Excel report.

The user can select counter name from predefined drop-down menu or enter it manually. 
The counter's name format is \<group name>(<instance name>)\<counter name>
(please refer to predefined definitions for examples).

To specify remote system name, please use \\<server name> notation.
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Show Execution Plan Feature

The Show SQL Statement Execution Plan feature is a component of DTM DB Stress tool. Only Enterprise version provides users
with this functionality.

This component enables the user to optimize SQL statements by execution details analyzing. A query execution plan outlines
how the Microsoft SQL Server or Oracle's query optimizer actually ran task's statement. This information is valuable when it
comes time to find out why a specific SQL statement is running slow.
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SQL Library

The SQL Library is a perfect way to organize or share your SQL scripts. The SQL Library is a 
hierarchy of files and folders. You can add your script to the library using Windows 
explorer. You can also save the script from DTM SQL editor into SQL library.

To access SQL Library click arrow "From Library" button at the main task properties page.
Please note that this option is supported by Enterprise edition of the stress test tool only.

The default location of the library is "library" subdirectory in the product folder. For 
example, "C:\Program Files\DTM DB Stress\Library". You can change this value using 
settings dialog

The SQL script selected in the library can be saved using one of the following methods:

 Insert - insert the file at the current cursor position.  
 Append - append the SQL file to the end of the script currently being edited.  
 Replace - replace the current script.  
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Report Comparison

The report comparison feature of the Enterprise edition is a perfect way to analyze results
of a few stress tests. To compare results:

 Define report file name for "internal format" at the project properties page. This file
must have ".strrep" extension. We recommend using $DATE$ and/or $TIME$ macros to 
get different reports automatically. 

 Run the project a few times or run different projects. 
 Specify report files to be compared by "Add" button. 
 Click "Compare" button to run report comparison. 
 "Save" button allows you to save the report to the disk file. 
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HTML Report, customization and localization

The installation folder of DTM DB Stress has TMPL subfolder. This subfolder contains files 
for HTML report customization and localization.

The HEAD.HTM file is a report header. The user can modify CSS items definitions to 
customize the report.

The ENGLISH.INI file is a text file that contains strings to be used in the report. The user
can create another file with localized or modified strings. The report settings allow the user
to assign alternate string file instead of ENGLISH.INI
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Version Control

The Enterprise version of the stress tool supports a basic level of the integration with MS 
Visual Source Safe. You can:

 Check out project file from VSS. 
 Undo Check out the module. 
 Check in the project file to VSS. 
 Add a new item to VSS project. 
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Import SQL Script Feature

This window helps the user to import SQL script from trace file (.trc) produced by Microsoft 
SQL Server Profiler. It is a perfect way to create realistic task definition based on existing 
application activity.
Just catch a stream of the executed SQL statements and load the list to DTM DB Stress by 
one click.
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Run SQL statements

The program has a special window where you can specify and execute any SQL statements. 
You can copy the results of executing a statement onto the clipboard or export it into 
various formats (text, SQL, HTML, XML or Microsoft Excel). Placing the mouse cursor over 
the column header will tell You the type of data stored in this field.

Menu item "Load" allows you to read SQL script from external file.

There is a picture of local menu accessed by the right click inside the results window.
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Report Visualizer

DTM DB Stress Report Visualizer is a supplemental utility that provides information from 
the report in a visual manner. Currently, it is available in Enterprise edition only.

Important: the visualizer has own system requirement: you need Microsoft .NET 3.5 SP1 or 
newer to run the utility.
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Program Installation

To run installation program:

 Open the windows Start menu and select "Run" item 
 Select or enter installation file name and path (stress.exe or stress_d.exe)* and click 

OK 

* - professional and enterprise editions of the tool may have another suffix.
 

Notes:

 Please be sure that existing version of the tool is not running when you install a new
version. 

 We recommend to uninstalling old version of the DTM DB Stress before new version 
installation.

 Installation by administrator for another user is supported for most environments. 
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Uninstall the Software

The Uninstall feature removes all installed DTM DB Stress components and all records in 
the Windows registry made by the installation script. You can uninstall this program by 
selecting the "DTM DB Stress" item in "Add/Remove Programs Dialog" in "Control 
Panel".

Another uninstallation way is to run "unins000.exe" from the product's folder directly.

Important! Uninstall feature of the program does not remove files and objects created by 
users such as configuration files, registry records etc.
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Log File

Log file

When running the program, you have to select one of menu items from "Tools->Log file" in 
order to view or truncate your Log file. The log file contains the detailed description of any 
errors and other events that occurred while processing script. 

Default log file location is product's directory and the name is ERROR.LOG. When the user 
has no enough permissions DTM DB Stress saves log to typical path like C:\Documents and 
Settings\<username>\Application Data\stress.log or 
C:\Users\<username>\AppData\Roaming\stress.log

The log file is a text file that contains three type of records:

1. The software product identification block: product name version and operating system 
information. 

2. Error records: wrong SQL statements, exceptions, etc. 
3. Notification and statistics.
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License Agreement (EULA)

This License Agreement covers all existing versions of DTM DB Stress (Software) and 
technical support service (Service). This License Agreement is a legal agreement between 
the end-user (Licensee) and DTM soft (Licensor). 

CAREFULLY READ THE TERMS AND CONDITIONS OF THIS AGREEMENT PRIOR TO USING 
THIS PRODUCT. USE OF ANY PORTION OF THIS PACKAGE INDICATES YOUR AGREEMENT TO 
THE FOLLOWING TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH SUCH TERMS AND 
CONDITIONS, DO NOT INSTALL THE SOFTWARE.

General Information

1. Licensor is exclusive owner of all DTM DB Stress copyrights. DTM DB Stress is 
protected by copyright laws and international copyright treaties. 

2. Demo version. Anyone may install and use demo version of DTM DB Stress for 
evaluation and testing purposes free of charge. 

3. The product is licensed, not sold. I.e. Licensor grants to Licensee non-exclusive, 
perpetual, royalty-free right and license to install, configure, execute and otherwise 
productively use a copy of the Software for the commercial or non-commercial 
purposes, including internal business purposes. Licensee may install and use each 
licensed copy of the Software on a single computer. The primary user of the computer 
on which DTM DB Stress is installed may make a second copy for his or her exclusive 
use on a portable computer. 

4. Licensee may not reverse engineer, modify, translate, decompile, or disassemble DTM 
DB Stress. The Software is licensed as a single product. Its component parts may not 
be separated for use on more than one computer. 

5. Licensee may not rent, lease, or lend the Software. Also, Licensee may not resell, or 
otherwise transfer for value, the Software. 

6. Without prejudice to any other rights, Licensor may terminate this License Agreement 
if Licensee fail to comply with the terms and conditions of this Agreement. In such 
event, Licensee must destroy all copies of the Software with all of its component
parts. 

7. Licensee may permanently transfer all of rights under this license, provided Licensee 
retain no copies, Licensee transfer all of DTM DB Stress (including all component 
parts), and the recipient agrees to the terms of this license.

8. DTM DB Stress IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED 
OR IMPLIED. LICENSEE USE DTM DB Stress AT YOUR OWN RISK. IN NO EVENT SHALL 
EITHER PARTY BE LIABLE FOR DATA LOSS, DAMAGES, LOSS OF PROFITS OR ANY 
OTHER KIND OF LOSS WHILE USING OR MISUSING THIS SOFTWARE. 

Delivery

Licensor delivers the Software electronically over Internet. The delivery includes 
installation/activation key, software, documentation* and additional materials with
installation program*. Licensor confirms that the delivery contains no illicit code or third 
party code.
The customers in North America allowed to request physical delivery on CD for extra fee.

*- the multiplatform edition of the software (if applicable) has online documentation only 
and requires no installation program.

Licensee Data

Licensor understands and acknowledges that Licensee may manage, modify, summarize, 
maintain, create derivative works of, and update pre-existing data and information, and 
generate, manage, modify, summarize, maintain, create derivative works of, and update 
additional data and information using the Software. Licensor acknowledges and agrees that 
all rights in any work product created by Licensee shall be solely owned by Licensee. 
Licensor has no access to mentioned work product without grant by Licensee. Moreover, 

 

 



  

 
 

 

 

 

  

 

Licensor shall not seek access to Licensee personal data.

Functionality

Licensor may remove or change any supplemental or non critical functionality of the 
Software without any notifications. Licensor may change product documentation and project 
file format. If Licensor deletes any key feature or functionality from the Software equal 
solution should be provided to Licensee without additional fee.

Third Party Software and Intellectual Property

Licensor hereby confirms that the Software contains no third party components including 
Open Source code.

Support and Upgrades

During one year after ordering any license of the Software except "Site" and "World" 
licenses, Licensee are entitled to free technical services and support for DTM DB Stress 
which is provided by Licensor. During this period, e-mail support is unlimited and includes 
technical and support questions. Also, during one year, Licensee may access to free 
updates to DTM DB Stress when and as DTM soft publishes them on www.sqledit.com. 
After end of the described period Licensee may continue to use the software product in 
accordance with the terms of this Agreement except free support and upgrades. After end 
of the free support and updates period (one year), Licensee may purchase annual Upgrade 
and Support subscription. If Licensee has a few licenses, Licensee will access to free
upgrade and support period and will use subscriptions independently.

There are two support service levels: Standard and Premium. By default, the Software 
includes Standard level of the Service. The Premium should be ordered separately. The 
Premium service offers reduced response time and high priority for support requests. The 
technical support response time for Standard level is between 2 and 12 hours except Jun, 
July and August with 2 to 24 hours range. It is available 5 days per week (Monday to 
Friday). For the Premium level it is 2 to 6 hours 7 days per week.

Export Compliance

Licensor hereby confirms that the Software requires no export controls at a level other than 
EAR99/AT.

Price Protection

Licensee who purchases volume license of the Software allowed to order additional copies 
with the same price during following period after initial deal: 3 months for 3 to 5 copies, 6 
months for 6 to 10 copies and 9 months for 11 or more copies.

Trademarks information

DTM DB Stress is trademark of DTM soft.

Licensee hereby grants DTM soft a right to use company name or trade names solely in 
connection with the rights granted to DTM soft pursuant to marketing materials and web 
site. If this clause breaches company policy DTM soft is happy to remove it upon request.
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Demo and Full Versions

What differences between the demo and full versions of the DTM DB Stress?

General functions

 Demo version allows the user to create only two tasks per project with up to 2 threads 
per task. 

 Demo version shows nag screen with each 4 minutes of the project execution. 

Supplemental functions

 SQL console partially replaces result values to DEMO string. 

No other demo limitations are present except nag-screen at program shutdown. 
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Technical support

If you have some question or unusual problem feel free to contact the DTM DB Stress 
technical support at support@sqledit.com 

When you contact technical support, you should be prepared to provide the following 
information: 

 DTM DB Stress version (you can find this information from About menu item of Help 
menu). 

 Type and version of the ODBC or IDAPI driver or OLE DB provider. 
 DBMS version and operating system version (including service pack version, if 

applicable). 
 DTM DB Stress Log file. 
 A description of what you do before the problem occurs. 
 Error messages you see when the problem occurs. 
 Your name, company name and how to contact you. 

See Also: log file
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How can I order DTM DB Stress software?

The software is available worldwide via the Internet. Secure online, mail/check and 
corporate purchase order options are available. For detailed information please click 
following link to open order page or copy http://www.sqledit.com/stress/order.html to your 
web browser. 

If you have any payment questions feel free to contact the DTM DB Stress technical 
support at support@sqledit.com
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How to upgrade your copy of DTM DB Stress?

The user can refer to "Check for Update" features to get information about available 
updates.
Please contact our support staff at support@sqledit.com to upgrade commercial version of 
the tool.

Demo version is available for download free of charge.

When you upgrade your copy of DTM DB Stress please send us the following information:

 You name, company name and how to contact you 
 Payment information (at least "ORDER No" and "Date") 
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Trademark Information

Microsoft Excel, Microsoft SQL Server and Microsoft Windows are trademarks of Microsoft 
Corp.

Oracle is a registered trademark of Oracle Corp.

PostgreSQL is copyrighted by PostgreSQL Global Development Group.

Borland Interbase is a registered trademark of Borland Software Corp.
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Database utilities by DTM soft

DTM SQL Editor (www.sqledit.com/editor) is a set of powerful database management tools 
that allow you to achieve two goals - to have unified access to different types of
databases and to have a set of solutions that makes processing your data easy. DTM SQL 
Editor gives database users, developers and administrators an ability to access different 
databases, whether desktop or client-server ones (provided you have ODBC driver 
installed). This is very convenient, since most organizations use several different types of
databases installed and each stores data in different formats and with varying parameters. 
Having a program that can get data from various sources is often essential. Furthermore, in 
addition to letting you quickly switch between different data sources, DTM SQL Editor lets 
you see database schema and results of the query execution.

DTM Migration Kit (www.sqledit.com/mk) is a powerful yet simple data migration tool that 
comes in handy if you run multiple databases. Use it to import, export or migrate data 
between different data sources (ODBC, OLE DB, or Oracle Call Interface supported). The 
program is fully automatic and supports all popular database formats. Simple visual 
interface lets you set own transformation and flow control rules to give you added 
flexibility.

DTM Schema Reporter (www.sqledit.com/sr) is a reporting tool for database schema. The 
program creates reports in RTF, HTML, XML or plain text formats and supports all common 
database interfaces - ODBC, OLE DB, or even Oracle Call Interface. This utility helps 
technical writers and database administrators create a report of any complexity level within 
seconds. Also, you can alter table order in the report and manually add annotations to the 
individual tables.

DTM Data Generator (www.sqledit.com/dg) is a simple, powerful and fully customizable 
utility that generates data for database testing purposes. Currently, database developers
and administrators often have to spend hours of dull work to create test data sets before 
examining database performance. This tool makes all this unnecessary by automatically 
creating database objects AND sets of SQL statements, if necessary.

DTM Data Editor (www.sqledit.com/de) is a data viewer and editor for database 
professionals who are tired of wasting their time on mundane tasks. The program uses 
form-based interface and works with any ODBC data source. SQL statements are generated 
automatically and can by modified later. For data that has foreign key - primary key 
relation, there are options to enter values manually or select them from a list, which is 
much faster.

DTM DB Stress (www.sqledit.com/stress) is a utility for stress testing the server parts of
information systems and applications, as well as DBMSs and servers themselves. This tool 
allows you to create and configure a continuous set of requests to the server of the OLAP 
(query execution) and OLTP (adding, modifying and deleting data in the database) types. 
At the same time, the user can flexibly change both the number and the priority of this or 
that type of requests to a database or an application.

DTM Data Modeler (www.sqledit.com/dm) is a CASE tool for database developers that 
supports both forward and reverse engineering. It is an easy-to-use tool allowing you to
work both with logical and physical data models in the form of an entity-relationship
diagram. The product is intended for database architects and developers and works with 
data sources via the ODBC interface, which means compatibility with all modern DBMS. 
Along with basic model properties (sets of entities and relationships between them), the
program allows you to create indexes and triggers on the physical level corresponding to 
the tables of the database that is modeled.

DTM Data Scrubber (www.sqledit.com/scr) is a set of intelligent tools for data verification
(audit) and scrubbing (cleaning). Depending on user-defined rules and data properties, the 
program either creates a report about the actual state of affairs or performs database data 
correction. 
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DTM Data Comparer (www.sqledit.com/dcmp) is a visual tool for data compare and 
synchronization. The program successively views the contents of both tables basing on the 
order of ascending of unique key values and shows differences or creates synchronization 
script. 

DTM Schema Comparer (www.sqledit.com/scmp) is a tool for database schemas comparison 
and synchronization. The comparison process supports tables, views, indexes, triggers and 
stored procedures. The visual representation of database schemas as a tree makes the 
comparison process more comfortable. 

DTM Query Reporter (www.sqledit.com/qr) is a reporting tool for database query. This 
utility helps technical writers, developers and database administrators create a report 
based on database query within seconds. 

DTM Schema Inspector (www.sqledit.com/si) is a database schema browsing and 
management tool that let you work with database schemas more effectively. 

DTM DB Event (www.sqledit.com/event) is a database monitoring and management tool. 
This utility allows the user to define a few situations (events). For each event the user can
define what the program should do if the event is occur. 

DTM Flat File Generator. Easy to use tool that helps any developer or QA engineer to create 
test data file. It supports tab-delimited, CSV, fixed width and custom separated output 
files. The generator has powerful import and export file structure features. 

DTM Test XML Generator. The tool is powerful generator for XML documents with structure 
defined by user and random but realistic data. More than 30 predefined generators with 
powerful pattern engine. The rich import XML structure options are available. 

DTM Data Generator for Excel is a tool for text Excel spreadsheet population. Easy to use
interface based on predefined generators, rich value library and high performance. 

DTM Data Generator for JSON produces JSON files with defined structure in a bulk manner. 
Fast and easy structure editor and smart import options helps the user to generate test set 
in a few clicks only. 

DTM Database Content Analyzer is a statistical tool for database content. It collects a few
dozens of most interesting data: database objects size, value frequency, clusters, etc. This
tool replaces and extends "Statistics" report of obsolete versions DTM Schema Reporter. 
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Clipboard support, export features

Export results of Query Execution

Types of export:

 text file with separators or with fixed columns width. 
 HTML file 
 XML document 
 RTF document 
 set of SQL statements (INSERT or UPDATE) 
 direct to Microsoft® Excel (installed Microsoft Excel required) 

Warning! Export for long binary data types (also known as BLOBs) is not supported.

Clipboard support

 Copy selected text onto Clipboard Ctrl-Ins, Ctrl-C
 Cut selected onto Clipboard Shift-Del, Ctrl-X
 Insert text from clipboard into cursor position Shift-Ins, Ctrl-V
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Glossary

Database catalog - The collection of system tables, tables that store metadata about that
specific database.

Database record - one row in a table (table can be a result of SQL-query). 

Database schema - logically connected, usually owner-based, set of DBMS objects (tables,
views, procedures etc).

DBMS - database management system. 

DBMS connection - the fact that both client and DBMS server have signed a contract and 
ready to query and data communications.

Drag-n-drop - the file manipulation technique when the mouse is used to move the file
from the place of storage to the program, which performs processing.

SQL language - the declarative language used to manipulate the data and its' structure in 
the modern DBMS and their client applications.

IDAPI - Integrated Database Application Program Interface, unified DBMS access interface. 

OCI - Oracle Call Interface, access interface for Oracle Server. 

ODBC - Open Database Connectivity, unified DBMS access interface. 

Metadata - information about data. See also: database schema 

SQL statement - single SQL operator having the complete role in a data manipulation 
script.

SQL-server - program or program complex, which is able to execute the SQL-queries. 
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